IDAC-4
Intelligent Data Acquisition Controller
with programmable output control

AUTOSPIKE
Software for Signal Recording and
Programmable Output Control

User's GUIDE

Rev. April 2004
# CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>2</td>
</tr>
<tr>
<td>Software</td>
<td></td>
</tr>
<tr>
<td>Device Interface</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>Hardware</td>
<td>3</td>
</tr>
<tr>
<td>SIGNAL CONNECTIONS</td>
<td>4</td>
</tr>
<tr>
<td>Input signals</td>
<td></td>
</tr>
<tr>
<td>Output signals</td>
<td>5</td>
</tr>
<tr>
<td>OPERATION</td>
<td>6</td>
</tr>
<tr>
<td>Recording</td>
<td></td>
</tr>
<tr>
<td>Record Control Bar</td>
<td>7</td>
</tr>
<tr>
<td>Record properties box</td>
<td></td>
</tr>
<tr>
<td>Times</td>
<td>8</td>
</tr>
<tr>
<td>Recording</td>
<td></td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
</tr>
<tr>
<td>File</td>
<td></td>
</tr>
<tr>
<td>Spikes</td>
<td>9</td>
</tr>
<tr>
<td>Digital</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td></td>
</tr>
<tr>
<td>FILTER SETTINGS and OFFSET CONTROL</td>
<td></td>
</tr>
<tr>
<td>Input Filters</td>
<td></td>
</tr>
<tr>
<td>WAVE FORM RECORDING</td>
<td>10</td>
</tr>
<tr>
<td>SPIKE DISCRIMINATION and SELECTION</td>
<td>13</td>
</tr>
<tr>
<td>SPIKE AMPLITUDE HISTOGRAM</td>
<td>14</td>
</tr>
<tr>
<td>SPIKE COUNTER</td>
<td>15</td>
</tr>
<tr>
<td>SPIKE FREQUENCY</td>
<td>16</td>
</tr>
<tr>
<td>AMPLITUDE and TIME MEASUREMENT</td>
<td>17</td>
</tr>
<tr>
<td>GRAPHICAL and NUMERICAL DATA TRANSFER</td>
<td>18</td>
</tr>
<tr>
<td>IDAC OUTPUT CONTROL</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>19</td>
</tr>
<tr>
<td>Programming</td>
<td>20</td>
</tr>
<tr>
<td>Digital outputs</td>
<td></td>
</tr>
<tr>
<td>Analog outputs</td>
<td>22</td>
</tr>
<tr>
<td>Trigger Synchronization</td>
<td>23</td>
</tr>
</tbody>
</table>
INTELLIGENT DATA ACQUISITION CONTROLLER
with
PROGRAMMABLE DIRECT OUTPUT CONTROL
IDAC-4
INTRODUCTION

The instructions presented here are aimed to serve as a guide to the installation and operation of the Syntech IDAC-4 and the application program Autospike. The IDAC-4 is a multi channel programmable data-acquisition amplifier/controller for the USB (Universal Serial Bus) and was especially developed for physiological signal recording, storage, and analysis. As with all novel instruments the user must invest some time and patience to gain sufficiently experience to operate the system smoothly. There is no risk for any electronic damage to the system or any device connected to it, nor to the integrity of the program code if the system is setup without having consulted the instructions; Nevertheless, it is highly recommended to read and use the instructions during installation and first operation.

The present manual is far from complete; it is nothing more than a brief introduction to the many features and options of the system. The best way of learning how to use the program is by exploration: just try out all possible settings, properties, and check the effect.

GENERAL

The Syntech IDAC-4 is designed for multi channel synchronous data acquisition for general electrophysiological research. The A/D and control circuits for the IDAC-4 are contained in a 19" box, which is connected to the PC via a single USB cable.

Up to 8 outputs for direct control of actuators (solenoids, valves etc) and 2 analog voltages can be programmed using the 'output control' module, which is part of Autospike. The output program can be synchronized with the signal acquisition.

The software runs on Windows98 and later Windows versions.

During operation all signals are continuously displayed in oscilloscope style on the PC screen at an adjustable time base. This facilitates fast and easy adjustment of signal levels, amplification factors, filter settings, and sampling rates, as the effect of changing a parameter is immediately visible.

The built-in power supply enables direct connection of input head stages and transducers without additional wiring and power converters. Problems induced by ground loops are avoided as the power supply and all inputs and outputs are galvanically isolated.
SOFTWARE INSTALLATION

1. Insert Software CD
   The CD is ‘auto start’; See Note 2 for manual start.

2. Click the button: Device

3. Select IDAC-4
   Finish the Device Interface installation.
   Return to Opening screen

4. Click on AutoSpike32
   For more programs to install return to this screen and select next program

5. Select Typical

6. Click Finish

7. Connect the USB cable
   Switch IDAC on (mains indicator LED goes ON)

8. Ignore Pop-Up comments

9. Windows searches for the IDAC-4 USB driver on the CD and installs this driver

10. Double click the AutoSpike32 Icon to start the program

Note 1: Do NOT connect USB cable until step 7.

Note 2: If this screen does not appear:
   Open the contents of the CD in Windows Explorer and run the file: INSTALL.EXE

Note 3: If this screen still does not appear:
   Open the contents of the CD in Windows Explorer and run the file:
   : \Drivers \Setup.exe

Note 4: If this screen does not appear:
   Open the contents of the CD in Windows Explorer and run the file:
   : \Drivers \Setup.exe

Note 5: If this screen does not appear:
   Open the contents of the CD in Windows Explorer and run the file:
   : \AutoSpike32 \Setup.exe

Note 6: The AutoSpike32 Icon appears on the Desktop

Note 7: Ignore Windows comments about compatibility and USB speed; just Continue
INSTALLATION

SOFTWARE

Note: *Install the software BEFORE connecting the IDAC-4 with the USB port!*

The Syntech software can be used with different Syntech interface devices (IDAC-4, Serial IDAC, USB-IDAC, IDAC-2 Interface board, IDAC-2000, etc.)

For a certain device to operate with the software the appropriate DEVICE INTERFACE must be installed.

First install the DEVICE INTERFACE for the IDAC-4, then install the application program (Autospike) followed by connecting the IDAC to the USB port.

DEVICE INTERFACE Installation:

1. Insert program CD ROM; The CD is "auto-run"; if the CD does not start automatically, the installation can be started manually:

2. Manual start: Run the file: INSTALL.exe

3. Click the "Device" button in the Installation Web Page

4. Select "IDAC-4" in the device selection box.

PROGRAM Installation:

5. After the driver has been installed, click the AutoSpike button.

6. Follow the instructions.

7. Select "CUSTOM" in the installation mode selection box

8. After the installation procedure is finished the hardware can be installed.

9. **DO NOT REMOVE** the CD from the station.

   *After the hardware is connected Windows needs this disk to activate the USB-driver for the newly detected hardware.*
INTELLIGENT DATA ACQUISITION CONTROLLER
PROGRAMMABLE OUTPUT DRIVERS

IDAC 4
UNIVERSAL SERIAL BUS

INPUTS / OUTPUTS
DIGITAL INPUTS
DIGITAL IN / OUT INDICATORS
DIGITAL OUTPUTS
1 2 3 4 5 6 7 8
ANALOG SIGNAL INPUTS
DIGITAL INPUTS
1-4

FRONT VIEW

25-pin Receptacles
providing digital input, output and power connections

6-pin Receptacles
to connect analog input devices
(probes) and differential signals

LED Indicators
showing status of digital inputs

LED Indicators
showing status of digital outputs

Mains Power receptacle
and power switch
100 - 240 V
50 - 60 Hz

Additional Power Input
(from external DC power supply)
to boost digital output power
12 - 24 V DC

Digital (12V) outputs
Connect actuator (valve) between upper and lower terminal screws;
upper terminals are +12V

Valve is activated
on software command

Cable receptacle

AUDIO output
(connect to loudspeaker set)

Closing a switch activates input

USB

ACM OUTPUTS / INPUTS

Central pin: analog signal
Outside: zero (0) or ground

Central pin: this pin is maintained TTL High (+5V)
Outside: zero (0) or ground

Input for active input devices:
headstages, probes, sensors and
signal sources

Connecting input of analog device
on software command

PC

25-pin input/output
control receptacle
1. Dig.out 1
2. Dig.out 2
3. Dig.out 3
4. Dig.out 4
5. Dig.out 5
6. Dig.out 6
7. Dig.out 7
8. Dig.out 8
9. Analog out 1
10. Analog out 2
11. +12 V
12. Common Ground
13. -12 V
14. Dig. in 1
15. Dig. in 2
16. Dig. in 3
17. Dig. in 4
18. Dig. in 5
19. Dig. in 6
20. Dig. in 7
21. Dig. in 8
22. Analog in 1
23. Analog in 2
24. Analog in 3
25. Analog in 4

BNC Receptacles
to connect analog input signals

BNC Receptacles
to connect digital input signals

25 pin input/output
combi receptacle

BNC Receptacles
to connect digital input signals

Central pin: analog signal

Central pin:
this pin is maintained
TTL High (+5V)

LED indicates mains power

LED indicates running
HARDWARE

1. Connect the power cord for the and insert it into the power outlet. (The IDAC-4 is suitable for 100 - 240 V 50 - 60 Hz.)

2. Set the mains power switch - above the power cord receptacle at the rear panel - at 1 (on). The 'MAINS' indicator LED is ON when power is received.

3. Connect the USB cable between the receptacle at the rear of the IDAC-4 and the USB receptacle of the computer.

   *Windows will now search for the appropriate driver for the IDAC-4. The required driver is available on the CD ROM; enter the path ( 'Drivers\IDAC-4) of the CD if prompted.*

   Windows indicates successful installation of the IDAC-4 USB driver

4. Activate the AutoSpike program by clicking on the AutoSpike icon. If the search is successful and the driver installed the Autospike program will show up with its initial screen.

6. **If a message is shown indicating that the IDAC has NOT been initialized, handle as follows:**

   1) Switch the power to the IDAC-4 (at the rear panel, above the power cord receptacle) OFF; wait a few second, and switch ON again.

   **and/or:**

   2) Select "CANCEL": *The program will now start partially (no record possibility) and CLOSE the program.*

   Start the program again (click on the Icon)

   3) While the program is searching for the driver, disconnect the USB cable from the rear of the IDAC-4 box, and - after a few seconds - connect it again.

   *These procedures might need to be repeated until the program starts, indicated by disappearance of the hourglass indicator.*

7. After a correct initialization the program starts with the main selection menu bar.
Note:

Installation of the IDAC-4 USB driver can be checked in the Device Manager after opening the Windows SETTING menu - Control Panel - System - Device Manager. In case the driver is not present reboot the computer and activate the AutoSpike program again with the IDAC-4 connected to the USB port and mains power.

Some early version of Windows98 may have problems with correct identification and installation of USB hardware drivers. It is recommended to install a recent (aug. 2000) Windows98 version or to upgrade to the most recent version. The IDAC-4 does NOT run with APPLE computers, even if they have a USB port, because of incompatibility with the operating system.

SIGNAL CONNECTIONS

INPUT SIGNALS

Analog Signal sources are connected to the system via the input receptacles at the front of the device. Output signals from amplifiers, tape recorders, signal conditioners, microphones, etc, can be connected directly to the BNC inputs. Signals picked-up from low voltage, high impedance, low ohm, and other delicate signal sources need to be conditioned by appropriate circuits. For these circuits the 6-pin DIN connectors are intended; they provide the necessary power voltages (+ and - 12V) and a differential signal input. The resistance of the signal inputs is 1 kOhm.

Digital signals, such as trigger commands, event signals, markers, stimulus duration signals, etc. are connected via the four digital input BNC receptacles. These signals may be either positive (4- 12 V) or negative (a closing switch), and can be momentary (transition from + to zero, or reverse) or continuously, indicating either an onset or offset or a status change (stimulus duration, etc).

The 1 - 4 inputs are available on the front panel; all the 8 inputs are also accessible on the rear panel (Digital Inputs) terminals and on the three 25-pin D connectors at the front.
OUTPUT SIGNALS

Audio output.

To make use of the audio signal output a suitable audio amplifier is needed. A cheap set of loudspeakers with built-in amplifier for computer audio monitoring is fully adequate, and plugs-in directly to the audio output. Some headphones (high impedance types) can be connected directly to the audio output.

Analog signals.

Two 12 bit programmable analog signals (-10 to +10V V) are delivered from the rear panel output terminals. The signals from these outputs can be programmed dynamically and in synchrony with the signal acquisition. They can be used to control linear actuators, flow controllers, motor speed regulators, light intensity, temperature etc. via appropriate driver circuits. These signals are 'control' voltages; they cannot deliver power. Please consult Syntech at syntech@knoware.nl for specific information.

Digital signals.

8 digital signals can be accessed from the rear output terminal. The signals can be programmed on the same time base and in synchrony with the signal acquisition for control of actuators like solenoids, valves, lights etc directly without the need for additional interfacing circuits.

All inputs and outputs and + - 12V power are also accessible through the 3 connectors (25 sub-D) at the front panel. However, these signals cannot drive actuators directly, as they are only TTL command signals.

Syntech Probes (active head stages) are directly connected to the multi-purpose input receptacles of the USB-IDAC.
GETTING STARTED

File menu:
- start new or open stored project

View menu:
- enable/disable tool bars, markers, etc.

Wave record mode:
- properties: RIGHT BUTTON

Record options:
- Wave
- Scales
- Properties
- Filter settings

Click the RIGHT mouse button, while pointing somewhere in the recording area; this will activate the PROPERTIES box related to the recording mode.
OPERATION

RECORDING

1) To activate the Recording mode start the AutoSpike program

If the program does not start, a message is presented; click Retry; if the program still does not start switch off the mains (110 or 220V) power to the IDAC-4 (the power switch is located above the power cord receptacle at the rear of the box) OFF and after a few seconds ON again. In most cases the program will start after a few trials.

(If the IDAC-4 is not connected click "cancel"; now the program can be used to operate on saved files; however, recordings cannot be made).

Before selecting the Record Mode first enable a few control boxes from the list presented after clicking on View:

2) Click on View
   It is recommended to activate the following tool bars:

   * Time base bar
   * Scale bar
   * Strip bar
   * Status bar
   * Markers

3) Select in the main FILE menu: New project.
4) Click on the menu bar of the aspk1 Project window
5) Click Record
6) Click Wave (Spike recording mod is discussed later)

The Wave record window is now activated. This window operates much like a multi-channel oscilloscope: all input signals are displayed on the screen in real-time. Like in an oscilloscope, the Sensitivity (input scale in V or mV), the Time base (writing speed in division/s), DC or AC mode, DC offset, Trigger modes, etc. can be selected or adjusted in control boxes to optimally display and capture the signals.

In the Record Control Bar the manual Trigger function, hold and storage buttons, and scale are operated and adjusted. More settings are accessible in the record properties Box, which appears after a Right-Click in the recording area.

Filter settings for the signals are adjusted in the ‘Filter settings’ in the record menu.
move the cursor somewhere in the recording area and click the RIGHT mouse BUTTON:
The PROPERTIES boxes appear

**Times**

**Recording Window:**
The value entered here determines the trace speed in the View mode.

**Max. Wave Recording:**
The recording time for a Wave recording.

**Max. Spike Recording:**
The recording time (in minutes!) for recording in Spike mode

**Autosave after max. recording time:**
Click this button to save each recording automatically and prepare the recording window for the next recording

**Recording**

**Strip Height (mm):**
The value entered here determines the size (height) of the signal strips

**Line:**
Select the color for the signal line.

**Grid:**
Select the color for the grid

**Background:**
Select the color for the background
RECORD CONTROL BAR

The scale acts on the selected channel; to select a channel click on the name in the upper left corner of the signal display strip. Use 'apply to all signals' to set the selected scale value for ALL signals.

RECORD PROPERTIES BOX:

This box has 7 tabs for different types of settings:

Times: The speed of the trace showing the signals in the View mode (before a trigger is presented) on the screen can be selected in this dialog box. The highest speed of the "oscilloscope" display is 1 s per sweep. A low speed is convenient for watching low frequency signals like sensors for temperature, light etc. Wave Time refers to the time after which a Wave mode recording must stop automatically. It is presented in seconds, but a high value may be entered. Note: Wave recording of long duration signals at high sampling results in relative long data files. Recording time and sampling rate should be optimized for this type of recordings to keep them manageable. Spike mode recording requires much less data space than wave mode recording. Therefore the recording time for spike signals is to be given in minutes.

Recording: The scale values (mV) are only correct if the pre-amplification of the signal previous to being connected to the IDAC input is entered here. For most Syntech Probes - with an internal gain of 10x - this value is 10. Other input devices might have different internal gain values. If the signal source generates an unamplified signal the value is 1.

For each input channel a sampling rate can be defined in this box. For the four analog channels together a maximum of 192000 samples/second is available. This maximum rate is distributed over the channels that are in use. The lowest rate is 1/s. To record the full frequency contents of a wave signal the sampling rate must be at least twice the maximum frequency present in the
The settings below operate on the signal during recording; the processed signal (multiplied, offset biassed, rectified and/or filtered) is stored; the incoming signal is not stored.

* **Fa:** Multiplication factor of incoming signal
* **Fb:** Offset addition of incoming signal
* **Rectify:** Rectification (absolute value) of incoming signal
* **Filter:** Filter settings on incoming signal
TRIGGER

The Pre-trigger feature allows recording of signals before the trigger command has been presented.

A Pretrigger value can be selected. This value is the time in seconds of the signal(s) recorded before the trigger command is presented.

The Trigger Level refers to the "Auto-trigger" option (if activated). A signal passing the selected level causes the recording to start.

FILE

In this box the name of the Project (File) and the recording channels is selected

* Prefix: First characters of Project (File) name
* Suffix: The names of the active channels. These names appear in the signal recording strips.
* Record group: The number of sequential recordings in the same Project.

SPIKES

Parameters for Spike detection and discrimination:

* Detection time window: between Min and Ma
* Minimum detection level (above noise) on the amplitude discrimination scale of 1 - 128.
* Store the SHAPE of the spike or only the amplitude (top - top value).
* Enter the time windows for spike shape storage: time before and time after the positive top.
**DIGITAL**

In this box the digital (event) signals are configured:

* Each digital channel can be enabled or disabled
* Each digital channel can be inverted:
  - Normally the signal is ‘low’ if the input is open.
  - If inverted the signal is ‘high’ if the input is open.
* One of the signals can be selected to function as the trigger signal, and its color can be set.
* One signal can be configured as ‘switch’ for the two spike frequency histogram memories (A, B).

**MODE**

Recordings can be stored in two modes:

1) Each recording (of one or multiple channels) starts at the left side of the page and starts at time=0.
   They are displayed in a single column, on top of each other.

2) Each recording (of one or more channels) starts where the previous recording stopped, and all recordings are stored on a single continuous time base.
signal. Too low a sampling rate results in distortion of the recorded signal, adds "quantization noise" to the recorded data, and may result in loss of significant information.

On the other hand, over-sampling does not increase the quality of the recorded data, but unnecessarily increases the file length of the recording.

For the digital input the maximum sampling rate is 1920, and is always the same for all digital inputs.

The maximum rate of 1920 is necessary for all recordings in which the time relationship between events (trigger, stimulus signal, etc) is essential. Lower rates will result in time shifts of a maximally 2 x the sampling rate.

**Trigger**

On presenting a trigger - either manually by clicking the trigger button in the Record Control Box - or by an external source connected to one of the digital inputs the acquisitions of the signals starts.

Setting a Pre-trigger prepares the acquisition system to store the signal already before the actual trigger command is given. This feature is very convenient for capturing unexpected events and for acquisition of signals from a tape recorder.

The value entered for Trigger level is the percentage of the signal level above zero that must be passed for an analog signal to start the acquisition automatically (Auto trigger). The value is the same for all 4 channels; however, each channel can be selected to respond to the auto trigger or not.

**File**

Recordings are stored as 'Projects', which may contain single or multiple recordings.

The 'File' box allows the user to configure the name of the project and the sequential numbers of the subsequent recordings. The signals are identified by the 'channel name or number' (entered in the Recording tab box) followed by the 'group' number; This number is automatically incremented after each new recording.

**Spikes**

Action potentials (spikes) characterized by a positive voltage peak followed by a small negative peak can be identified during signal acquisition or after the signal(s) have been stores.

Several parameters for spike identification: time before the positive peak, time between positive and negative peak, and a threshold level can be defined here.

The shape of identified spikes can be stored; the portion of the spike to be stored can be defined; to store the spike shape, the "Shape button" must be on.

If only spike amplitudes (top-top value between positive and negative peak) are stored the "Shape" button should be off.
FILTER SETTINGS, OFFSET and AUDIO

Click the F button

Filter, Offset and Audio control for channel 1 - 4

Select High cutoff frequency (no offset adjust)

Select Low cutoff frequency (no offset adjust)

Select DC for DC recording mode and OFFSET adjustment

Effect on signal

Zero button

Slider for COARSE adjustment

Arrow buttons for FINE adjustment

EAG filter

DC mode

Additional Settings

Apply filter settings to ALL channels
Digital  

Two digital input signals can be assigned a special function:
1) to serve as trigger to start the acquisition
2) to switch between Spike Histogram A and B in spike mode recording.

The color of these two special signals can be selected.
The polarity of all digital input can be reversed. Normally the input responds to a positive input signal; In reverse the inputs are active during a low input (closed input). The latter configuration is suitable for trigger signals from closing contacts (pedal switch, GC start relay, etc).

Mode

Signals can be recorded in two modes:
1) On a common time base; all signals start at time = 0 and are stored and displayed on top of each other like lines in a book.
2) On a continuous time base; Each new recording starts where the previous recording ended. The signals are stored and displayed on a 'single line'.

FILTER SETTINGS and OFFSET CONTROL

Input filters

Each analog input channel is provided with programmable analog low and high pass filters, the settings of which can be adjusted in this box. The purpose of the filters is to condition the signal for proper digitalization by the analog to digital converter in the IDAC.
It is important to select the proper filter settings dependent on the kind of information to be derived from the recorded signals. To record information of low frequency character a high pass filter should be set at a low value. For signals containing very low frequency information (like EAGs) the low-pass filter must be set at a low value or at DC. For accurately measuring signal levels, a DC setting is necessary.

In case DC is selected, it is possible to compensate DC offset on the incoming signal using the offset slide bar.
The Zero button (or the Z-key) temporarily overrides the Low pass filter; This button is convenient for Low pass filter settings below 1 Hz, as it results in a quick return to the base line after a large signal transient. 50 or 60 Hz hum induced power line can be suppressed; However, this filter might introduce some offset in the recorded signal.
WAVE FORM RECORDING

Wave recording is the standard signal acquisition mode of the IDAC-4.

Up to four analog signals and eight digital (command) signals can be recorded simultaneously. All signals are presented in an oscilloscope-like appearance on the monitor screen.

Activate Wave recording:

1) Start the Autospike program
2) Click on File in the main menu
3) Select New Project
4) Click on Record
5) Select Wave

The Wave Record Window now appears.

In case no signal sources are connected to the inputs the window shows horizontal lines in the center the display area running from left to right. The center of the display area represents the zero level of the inputs signal. Negative voltage fluctuations are indicated by the line moving down, positive by upward deflections.

After the signal sources are connected the display of the signals can be adjusted using the record control box and the recording properties (Pre-trigger, Filter and Offset adjustments) should be selected.

If less than 4 signals are recorded, the non-used channels can be disabled.

Start Acquisition:

1) Using the Trigger button in the record control box:
   Give a left mouse click on the Trigger button.
2) By means of an external (closing switch) signal:
   Connect a (pedal) switch to the digital input that is configured as trigger input and press the pedal.
3) From stimulus device producing a positive voltage output:
   Connect this output to one of the digital inputs, configure this input as trigger, and set its polarity to inverse.
4) By the analog signal itself when passing a (positive) threshold:
   Enable the Auto trigger for that channel and adjust the threshold in the trigger Properties.
   In addition connect a pedal switch to the digital input, which is configured as trigger input.
Select signal(s) to store and to display

A list appears showing all recordings made so far in the current project

Display Mode:
all in a single strip or in separate strips (recommended)

Recorded signals are shown at time base of 100 ms/division

Selected signals are displayed in the Output window on a default time base of 100 ms/division.

The time base can be changed in the Timebase Bar (to enable this bar open the View menu)

Click this button to select ALL signals

Leave recording mode
The auto trigger is hold-up (to avoid false triggering during pre-adjustment of the signal) until a command is given by the pedal switch. This 'wait status' is indicated by the status indicator.

Stop acquisition:
1) Manually:
   Click the Pause button in the record control box.
2) Automatically:
   Wait until the pre-set recording time is elapsed.

Continue acquisition:
1) Click the Pause button again.

Erase and Redo:
Click the Clear button; this erases the previous recording from memory and prepares the system for the next acquisition.

Save recording(s):
Click the Save button, and leave the Record mode.

A Selection window appears showing a list of all signals recorded during the last acquisition. The signals are named and numbered according to the settings in File.

Display options:

Time base: Use the time base numerical scroll windows or the 'Enlarge-Reduce' buttons.
Note: All signals are presented on one and the same time base; within a project the time base cannot be adjusted differently for different signals. To display and operate on a different time base the project must be saved under another name and opened as a new project.
Multiple projects can be managed simultaneously under Windows, and information can be transferred via the clipboard.

Scrolling: Use the horizontal scroll bar of the Output window.

Amplitude: The amplitude of each signal can be changed;
1) Select the signal by clicking the Name Box (the edge of the box is highlighted)
2) Change the mV value in the Scale bar; intermediate values may be entered.

Strip height: Use the + and - buttons in the Strip bar.
Or enter a value in the Strip properties.
Time base: Operates on ALL strips

Scale: Operates on Selected Signal only

to select Signal: Click on Name box

Strip bar: Operates on ALL strips: change size, properties, grid, scale, etc.

Strip properties:
Operates on the selected strip. Tab boxes to change colors, grids, scale indications, styles.
Default values can be assigned to all strips by selecting “Set all strips to default”
Strip Scroll: Use the right-side scroll bar of the Output Window. The number of currently visible and non-visible strips is indicated in the Status bar enabling in the View menu.

Strips: The output window is organized in strips, in which the signals are displayed. Signals can be arranged in a single strip or distributed over as many strips as needed. The properties of strips (background color, grid, scales, etc.) can be defined individually for each strip, or as default for all strips. Signal properties (line thickness and color) are adjustable for each individual signal and are independent of the strip settings. Right-Click the Name Box of the signal to access the signal properties.

Grid and Scale: A right mouse click in the strip area presents the strip properties box, in which the characteristics for the selected strip can be adjusted.

Signal data: Acquisition settings for a signal are shown in the properties box appearing by right-clicking the signal’s name box:
   1) Signal Name
   2) Rec. Factor (= ext. amplification)
   3) Sampling rate

Offset: Signals can be individually moved up and down in the strip display field using the offset slide bar. The offset slide bar appears after a Right-Click on the signal Name Box followed by selecting Offset. Depending upon how signals are related they can be arranged all in a single strip or grouped into different stripes, each with their own background, grid and scale settings.

Overview: The overview (to enable in the View menu) is aimed to show the full recording period. To add signals to this window give a Right-click inside its display field end select a signal from the list. Two cursors, each linked to a box showing the time position, can be moved together or relative to each other. They allow fine and numerical selecting of any time base section. It is convenient to downsize the overview window into a strip below the output view.
**Re-arrange Signals:**

To move a signal trace to another strip:
Select signal name box and drag box to other strip

**Display and Operate 2**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Natural
- Correlation
- Digital

**Offset Adjust slide bar**

**Strip properties:**
Click right mouse button while pointer in strip

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip contents and properties**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Point in empty display area and click right button**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip contents and properties**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
RIGHT BUTTON:

**Click right mouse button while pointer in strip**

**Offset adjust slide bar**

**Show or Hide signal by clicking the signal button**

**Select signal(s) to be added**

**Signal List**
Select signal(s) to be added

**Signal**
- Rectified
- Amplitude
- Spike
- Correlation
- Digital

**Add signal**

**More Strips:**
Point in empty display area and click right button

**Horizontal scroll bar**

**Vertical scroll bar**

**Strip properties:**
DISPLAY and OPERATE 3

Signals arranged in multiple strips

All signals in a single strip

Signals arranged in a single strip

Use offset slide bar to arrange vertical position of signals

Individual signals in can be hidden (visibility can be "switched on-off")

Signal in center is hidden

Properties of signal traces: right-click

Name label

Acquisition Data

Line and Color parameters

Signals arranged in multiple strips

Time base selection bar

Time base selection using OVERVIEW window

First cursor

Second cursor

Overview

Section between cursors

Overview

Cursors on small distance

Time base ZOOM by Mouse dragging
Spike Discrimination and Selection

Select To Spike

Open Properties of signal by right-clicking the NAME BOX

Convert Wave to Spike dialog box appears

The SPIKE trace is presented on top of the Wave signal trace immediately after conversion. The Wave can be "switched off" to show the Spike signal only.

Detection Time window

Pre-top time limit

Post-top time limit

Detection Threshold (on scale of 128 points)

Click this button to store the SHAPE of the spikes

Vertical scale: number of spikes counted in amplitude classes (1-127)

Horizontal scale: Amplitude classes (1-127)

Use Properties to change colors, line thickness, etc of Spike signal. Select a weak color for "OUT of Range" and a prominent color for "Selected" spikes.

Amplitude HISTOGRAM

Small spikes

Large spikes

Small amplitude spikes selected (blue; out of range: grey)

Large amplitude spikes selected (blue; out of range: grey)

Click this button to the shape

Spike Amplitude Histogram

SHAPE storage window

Detection Time window

Pre-top part

Post-top part

Spike selection bar

Selected Spikes

Small spikes

Large spikes

Small amplitude spikes selected in histogram using selection bar

Large amplitude spikes selected in histogram using selection bar

The SPike trace is presented on top of the Wave signal trace immediately after conversion. The Wave can be "switched off" to show the Spike signal only.

The SPike trace is presented on top of the Wave signal trace immediately after conversion.
SPIKE DISCRIMINATION and SELECTION

Action potentials (spikes) recorded as Wave signals can be extracted from the analog wave form and classified according to their top-top amplitudes. Once the spike signal is generated spikes can be counted with respect to a cursor or in adjustable time periods (bins), and the momentary frequency of the spike train can plotted. All these functions may operate on user selected groups of spike classes.

Discrimination: In most spike analysis software packages the spikes are discriminated from the original signal by setting a threshold above which transients are processed as spikes. This procedure fails if the spikes are superimposed on base line fluctuations or strong 50 and 60 Hz hum. Therefore, the discrimination in Autospike does not use a threshold, but detects the spikes on the basis of their typical shape, irrespective the position of the spike with respect to the base line.

Convert to spikes: 1) Select a wave signal; adjust the overall amplitude of the signal such that it fills the whole width of the strip; however, without peaks being clipped. Using the full width of the strip gives the best classification over the available 128 amplitude classes.

2) Right-Click on the name box to get the Properties box, and select "to Spike". The "Convert wave to spike " dialog box appears.

Detection time: "Spike-like" transients in the signal are detected as spikes if falling within a certain time span relative to the positive top of the transient. Set pre- and Post- time limits.

Threshold: A threshold can be defined below which transients are ignored. This threshold is a value on a scale of 128 steps (the amplitude classes) and is linked to the top-top amplitude of the spike; it is independent from base line fluctuations. Set the threshold to 0 if the noise level in the signal is unknown, and adjust the level after spike conversion in the histogram.

Shape: Detected spikes are stored as amplitudes representing the top-top amplitude or can be stored as "wavelets" maintaining the waveform of the spike. Pre- and Post times delineate the section to be stored.

New name: Each spike signal must be identified by a unique name.
**SPIKE AMPLITUDE HISTOGRAM**

**TIME BASE SELECTION IS LINKED TO HISTOGRAM**

- A large number of spikes is selected: all the spikes in this time span are classified in the histogram and shown in the overlay.
- The HISTOGRAM is linked to the selected Spike signal; Changing the time base of the Spike signal will automatically actualize the histogram.

- A few spikes are displayed: only the spikes in this short time span are classified in the histogram and shown in the overlay.
- The HISTOGRAM is linked to the selected Spike signal; Changing the time base of the Spike signal will automatically actualize the histogram.

**HISTOGRAM APPEARANCE**

- Use Up - Down Arrow to adjust vertical (N) scale of Spike Histogram.
- Properties of Histogram (right-mouse click).
- Resolution and Colors changed using Properties.

**In Spike Conversion spikes can be extracted as SHAPE or as AMPLITUDE**

- **SHAPE**
  - Window: "Properties Dialog" dialog box.
  - Shape/Amplitude selection button.
  - Shape button.
  - Shape/Amplitude selection property.

- **AMPLITUDE**
  - Window: "Properties Dialog" dialog box.
  - Amplitude button.
  - Amplitude/Shape selection property.

**SPIKE OVERLAY shows shape of selected spikes**

(Adjust the amplitude of the overlay spikes using the Scale bar while the Histogram window is activated.)
SPIKE AMPLITUDE HISTOGRAM

Detected spikes are classified according to their amplitudes in 128 classes. The number of spikes in each of the classes is represented by a vertical bar, resulting in a histogram of 128 bars (classes 0 - 127). Distinct spike amplitude groups are immediately visible in such a histogram. Variation of spike amplitude within an amplitude group is reflected in the width in the histogram.

The information in the histogram always only refers to the spikes visible in the signal display strip containing the spike signal. Zooming in or out on the time scale is followed by a refresh of the histogram.

Amplitude selection: Groups of spikes of similar amplitude can be selected in the histogram by dragging the two cursors (little squares) at the ends of the line. The projection of the line delineates the classes of spike selected. The associated spike signal is immediately adjusted.

Spike overlay: Selected spikes are presented as overlay in the area to the left of the histogram. Characteristic classes of spikes are easily recognized from the overlay. The amplitude of spikes in the overlay display is adjusted in the scale bar; this is only possible if the histogram is the active window (Blue title bar). The overlay is only active if spikes are detected as shape.

Vertical scale: The vertical scale represents the number of spikes counted in the classes. The scale can be changed using the up-down button in the control bar on top of the histogram.

Histogram cursor: A cursor appears in the histogram on pointing in the display area. At the same time the number of spikes and the class number are presented belonging to the position of the cursor.

Spike counts: The numbers of all spikes in the selected section of the spike signal as well as the number of the spikes selected in the histogram are presented in the histogram (Tot = total Nr.; Sel = selected). Values are linked to the signal and the selection line.

Class resolution: The number of classes can be selected from 4 resolutions. Right-Click the histogram area to get the properties box.

Colors: 1) of spikes in the spike signal: Right-click on the name box to open the spike properties box, in which the colors for selected and out of range spikes can be changed, as well as the line thickness.

2) in histogram: Right-click the histogram area.
Select Spike signal strip

A CURSOR appears: move the cursor to the position from where spikes must be counted

Open Properties (right click on Name Box)

Select: Spike counter

A Right-Mouse click on the cursor opens a Property box

Pre- and Post time counting periods can be set in the Properties of the cursor, which is presented on a right-mouse click on the cursor

Open Properties (right click on Name Box)

Select: Add

Select Spike signal strip

Spikes can be counted on any position in the signal where a spike counter cursor is placed.

Spikes are counted before and after the cursor.

Spike counter cursor is placed

A Right-Mouse click on the cursor opens a Property box

Pre- and Post time counting periods are entered in ms; default values can be set or the values can be set for each individual cursor

Spike signal trace showing multiple spike counter cursors placed

Each cursor presents 3 values: pre-, post, and difference counts. Numerical values of spike counts can be transferred individually or together to the clipboard

Open the Properties box to transfer the values to the clipboard for transfer in other programs

<table>
<thead>
<tr>
<th>Name</th>
<th>Time (ms)</th>
<th>pre-t</th>
<th>post-t</th>
<th>pre-N</th>
<th>post-N</th>
<th>diff. N</th>
</tr>
</thead>
<tbody>
<tr>
<td>spk1</td>
<td>6777.2</td>
<td>200</td>
<td>500</td>
<td>14</td>
<td>36</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>7633.5</td>
<td>100</td>
<td>300</td>
<td>0</td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>8710.8</td>
<td>100</td>
<td>200</td>
<td>6</td>
<td>20</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>9074.4</td>
<td>50</td>
<td>100</td>
<td>5</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>9792.6</td>
<td>200</td>
<td>500</td>
<td>14</td>
<td>36</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>10829</td>
<td>50</td>
<td>200</td>
<td>5</td>
<td>20</td>
<td>15</td>
</tr>
</tbody>
</table>

Numerical output of all spike counts transferred to Windows Excel via the clipboard
SPIKE COUNTER

Spikes can be counted interactively using spike count markers, which are placed in the spike signal trace. The time sections before and after the central cursor of the markers are user defined for all markers or for each marker individually. Spikes are counted before and after cursor and the difference is calculated. The numerical values can be transferred via the clipboard to other applications such as Windows Excel.

Add spike counter:  
1) Select a spike signal  
2) Right-click on the name box  
3) Select Spike counter  
4) Select Add

A marker appears in the spike signal strip. Use the mouse to drag (left button down) the marker into position

5) Release the left mouse button to fix the marker

A marker can always be re-positioned by selecting the central cursor by a right mouse click followed by dragging.

Counter properties:  
1) Select the marker  
2) Right-click the central cursor  
3) Select properties

The counter properties box appears  
4) Enter the Pre- and Post- marker times  
5) Click OK

The values refer to the selected marker only, unless the box "Make default" is selected.

Number of markers: An unlimited number of markers can be positioned in a single or multiple signals. Each marker may be assigned its own counting times.

Delete markers: Counting markers are deleted individually or all using the command in the properties box appearing after a right-click on the central cursor.

Data transfer: Data of all or individual counters are transferred to the clipboard using the appropriate command in the properties box appearing after a right-click on the central cursor.
SPIKE FREQUENCY

Convert Wave to Spike

After a Wave signal has been converted to a Spike signal the momentary frequency of the spike signal can be presented in a Frequency plot or curve.

Use HISTOGRAM to select spikes; Move Spike signal to empty strip

The Frequency plot is based on the selected spikes. Changing the selection in the HISTOGRAM automatically adjusts the Frequency plot.

Right-Click to create new strip

Right-Click the strip to open the Insert box. Select Signal Select Frequency

A List of recorded and converted signals appears. Select the Spike signal for the Frequency plot; Multiple signals can be selected.

The SCALE bar automatically changes to Hz when Frequency is selected

Use color contrast in multiple frequency display, or use multiple strip display

Use Properties of selected graph to change display parameters:
- Bin width, Bar Graph, Line curve
- Line thickness, Smooth filter, Colors

Open Strip Properties to add/select GRID, SCALE etc.

Open Properties of Frequency signal (Right-Click in Name Box)

Open of Frequency signal (Right-Click in Name Box)

Use HISTOGRAM to select spikes; Move Spike signal to empty strip

Frequency bar graph of spk4(2) (Blue) and spk4 (Red)

Frequency bar graph of spk4(2) (visible) and spk4 (invisible)

 BIN size adjusted
LINE mode display
SMOOTH filter applied on line

Frequency bar graph of and spk4(2) (Blue) spk4 (Red)

The bar automatically changes to Hz when Frequency is selected

Multiple signals can be selected
SPIKE FREQUENCY

The firing rate of spikes in a signal can be presented in a bar graph or line plot showing the momentary spike frequency at any position in the signal. As this feature only applies to spike signals a wave signal containing action potentials is first converted to a spike signal and the relevant spike amplitude classes are selected using the histogram (pag. xx).

Add frequency signal: 1) Select a spike signal or convert a wave to a spike signal.
2) Select the class group of spikes to be measured in the associated histogram
3) Create a new strip by Right-clicking on the open area below the strips.
4) Right-click in this empty strip
5) Select Add signal
6) Select Frequency

A Selection window appears showing a list of all signals recorded during the last acquisition. The signals are named and numbered according to the settings in the File parameters box (page 8).

7) Select the signal.

Multiple signals are selectable simultaneously; they are placed in a single or multiple strips depending on the status of the associated selection button.

Adjust frequency scale: 1) Select the frequency plot
2) Adjust the vertical (Hz) scale in the scale bar

The scale bar is linked to the selected signal and automatically changes to a frequency (Hz) scale if a frequency signal is selected.

Select time base: The time base of the frequency plot is the same as in all other signal strips. Time zoom and operations in the time base bar have the same effect on all strips including the frequency signal.

Frequency properties: 1) In Bar mode the BIN size is adjustable
2) In Line mode a smoothing (Low pass) filter can be applied to the line.
3) Colors and line thickness are adaptable.
Select a Wave signal to be measured.

MULTIPLE MEASUREMENTS CAN BE MADE IN A SINGLE OR IN MULTIPLE SIGNALS

In Wave signals amplitudes and time periods can be measured with a set of cursors.

Open the signal Properties by a Right-Click on the Name Box.
Select Measurement Select Add

A set of cursors appears:
After a Left-Click the cursor splits into two, which can be positioned independently.

Two perpendicular lines connect the cursors, which automatically follow the signal.

Amplitude and time between the cursors is shown in two boxes.
The values are linked to the position of the cursors.

Measurement Properties appear by a Right-Click on the left cursor.

Instead of exactly following the signal trace the left cursor can be made to present an average value of a time period before the cursor.

MULTIPLE MEASUREMENTS CAN BE MADE IN A SINGLE OR IN MULTIPLE SIGNALS

<table>
<thead>
<tr>
<th>Signal name</th>
<th>T average</th>
<th>Time 1</th>
<th>Time 2</th>
<th>T diff.</th>
<th>V diff.</th>
</tr>
</thead>
<tbody>
<tr>
<td>example6(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>3840.5</td>
<td>4089.1</td>
<td>248.6</td>
<td>-258.38</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>8669.3</td>
<td>8986.6</td>
<td>317.3</td>
<td>-137.04</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>13718</td>
<td>13960.5</td>
<td>242.5</td>
<td>-245.18</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>17548.7</td>
<td>19002.6</td>
<td>1453.9</td>
<td>-150.9</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>23569.2</td>
<td>23943.1</td>
<td>373.9</td>
<td>-261</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>28568.1</td>
<td>28804.2</td>
<td>236.1</td>
<td>-131.38</td>
<td></td>
</tr>
</tbody>
</table>
AMPLITUDE and TIME MEASUREMENT

In wave form signals amplitude and time differences can interactively be measured by means of a pair of cursors, which are placed anywhere on the signal. A many of these cursor pairs can be placed as needed and the numerical data can be transferred to the clipboard.

Add measurement:  
1) Select the strip and the signal of interest  
*The measurement option applies to wave signals only.*  
2) Right-click on the name box to open a selection box  
3) Select Measurement  
4) Select Add

*A pair of cursors appears. Each cursor can be moved along the time base axis and automatically follows the signal trace. The time between the cursors and the voltage differences are numerically presented in two boxes associated with the cursors. Zoom-in for more detail and enlarge the strip.*

Average option:  
In many measurements it is advantageous for the first position point (cursor) to represent an average of the foregoing signal rather than the exact momentary value. For this purpose the first cursor can be assigned a certain time span over which the average signal value is calculated.

Average time:  
1) Right-click the first (left) cursor.  
2) Select Properties  
3) Enter an average time in ms.

*The value refers to the selected cursor only, unless the box "Make default" is selected.*

Number of markers: An unlimited number of measurement markers can be positioned in a single or multiple signals. Each marker may be assigned its own counting times.

Delete markers: Measurement markers are deleted individually or all using the command in the properties box appearing after a right-click on the left cursor.

Data transfer: Data of all or individual markers are transferred to the clipboard using the appropriate command in the properties box appearing after a right-click on the left cursor.
GRAPHICAL and NUMERICAL DATA TRANSFER

COPY AS METAFILE TO CLIPBOARD

The contents of the active window can be transferred to the clipboard. From the clipboard, it can be pasted into another document.

Select Edit in the main menu and click at Copy as metafile.

The "Copy as metafile" command transfers only the contents of the ACTIVE (Blue window bar) window.

In the Output window, only the contents of the SELECTED strip (Blue side bar) is transferred.

A signal Strip becomes active after selecting one of the signal Name Boxes in the strip.

The clipboard transfer can also be applied to the Histogram and Overview windows.

NUMERICAL DATA EXPORT

Select File in the main menu and Export to.

A list appears showing the available data in the current project.

Select the signal or histogram data to be exported.

Note that ASCII data files of Wave signals may be very long, especially if the signals are recorded at high sample rate.

The SAPID format contains the first 3 s of the signal only.
The information of most output windows can be directly transferred into other applications in windows metafile format using the Windows clipboard function. Alternatively, the complete graphical output or a part of it can be printed using the Print and the Print Preview commands in the File menu.

The metafile transfer feature is very convenient if graphs have to be pasted into a text report or assembled together for a presentation. The numerical values of measurements and spike counts can be pasted directly into spreadsheet packages like Windows Excel for further processing.

Metafile properties:
1) Select Main properties in the File menu
2) Select the Metafile tab
3) Include or exclude the Signal legend (=name box) to be copied with the metafile.

Strip contents copy:
1) Add signals to a strip or select them using the visibility button (page 11), and adjust the scale and appearance parameters.

*Only the selected strip (Blue side bar) will be copied to the clipboard*
2) Click Edit in the main menu bar
3) Click Copy as Metafile
4) Open the target application
5) Use the Paste command to insert the metafile into the application.

Numerical data:
A) Measurement and Spike counter values (pag. xx) are transferred to the clipboard using commands linked to the left cursor.

B) Histogram and Signal numerical data:
1) Select Export to in the File menu
2) Select one of the export formats
3) Select the Histogram or signal from the list.

*SAPID files are in 16 bit format and contain the first 3 seconds of the recording only.*

*ASCII files may become very large for signals recorded at high sampling rate during (relative) long periods.*
IDAC OUTPUT CONTROL

SPECIFICATIONS

Digital

* 8 channels
* TTL outputs and powered outputs
* Powered output voltage 12V (internal power supply)
* Total drive current: 800 mA (internal power supply)
* 12 - 24 V external boost power supply
* Maximum run time: 10 hours
* Time resolution: 1 ms

Analog

* 2 channels
* Range: - 10V to + 10 V
* Drive current: 20mA each channel
* Resolution: 12 bit
* Maximum run time: 10 hours
* Time resolution: 1 ms
Open output control

click RIGHT mouse button

select output channels

Output Programming Box

click the signal to operate on

CONTROL BAR

File name

increase or decrease time scale

set all to time of selected signal

zoom in on selection

Load data in IDAC

Run

Stop

select signal

increase or decrease strip HEIGHT

Range and Duration (analog) adjustment

signal duration

增加 or decrease amplitude scale (analog)

zoom scale in on selection

set scale to max. (analog) range

ANALOG ONLY

click on Add

click on Add

Add

Size

View Properties...

Signal Duration...

Fit to...
OUTPUT CONTROL

GENERAL

IDAC-16 and IDAC-4

The Syntech signal acquisition systems IDAC-16 and IDAC-4 are provided with 8 digital and 2 analog programmable outputs. The digital outputs of the IDAC-16 are TTL (+5 V command signals) outputs only. Those of the IDAC-4 are configured both as TTL signals and as 12 - 24 V outputs capable of driving external actuators, like solenoid valves, without the need for interface electronics. A total power of 800 mA at 12 V can be delivered to the actuators. To drive devices at a higher total power rating or higher voltage (max. 24V) an external power supply can be connected.

Programming

The on/off (0 / +5 V) status of the digital outputs and the voltage value (between -10 and +10 V) of the analog outputs is programmed using the IDAC OUTPUT CONTROL software, which is part of the Autospike program. The output states can be set with a temporal resolution of max.1 ms, and the analog values have an accuracy of 12 bit over the 20 V range. The maximum programmable time span is 10 hours.

Trigger and time base

The programmed output sequence is triggered independently or linked to the signal acquisition of Autospike. Programmed TTL output signals can be used to (repeatedly) trigger acquisition and A/B control in Autospike, thus allowing time programming of consecutive Autospike recordings.

Monitoring

The status of the digital outputs is monitored by the 8 LEDs on the front panel of the IDAC-4. Recording the status in Autospike of one or more digital input channels is possible by connecting the output signal(s) to the inputs. A 'loop back' connector for one of the 3 in/out 25-pin receptacles is available to wire all (TTL) outputs directly to the digital inputs.

Analog signals

The analog outputs provide ‘control signals’ only, as they can only supply a max. current of 20 mA each. Most electronic mass flow controllers are provided with inputs directly compatible with this signal. To control the intensity of lights, or the direction and speed of motors, a suitable interface circuit is necessary. Consult Syntech for specific information about these applications.
PROGRAMMING

DIGITAL OUTPUTS

1. Start IDAC Output Control

   The output control program is accessible in two ways:
   * After opening a project in Autospike:
     in the File menu: "Idac output control..."
   * In the Wave recording mode: click the IO Control button.

   A new file can be created or an existing one opened in the File menu.

2. Open the 'Select signal' box to select the channels to be programmed.
   * By a RIGHT mouse click in the empty Control box,
     followed by 'add signal'. Or by a click on
   * In the 'Strip' menu select 'Add'.
   * Select the channels in the 'Select signal' box

3. Define the signal duration
   * Click the 'duration' button:
   * Enter the maximum duration of the programmed output sequence.

4. Adjust the height of the signal strips
   * Click the 'increase' or 'decrease' buttons:

5. Adjust the visible part of the total duration (zoom)
   * Click the 'increase' or 'decrease' buttons:

6. Select one of the signals to be programmed by a click on the name (Digital1,...8)

7. Setting 'ON' and 'OFF' points:
   * ON: place the cursor in the UPPER part of the strip and click LEFT.
   * OFF: place the cursor in the LOWER part of the strip and click LEFT.

   The exact position of the cursor is presented in the lower right corner of the box

8. Moving points:
   * Place the cursor on the point, keep the LEFT mouse button down while
     dragging the point

9. Editing points:
   * Place the cursor on the point.
   * The point turns GREEN after a LEFT mouse click
   * Click the RIGHT mouse button to open the edit menu.
   * Select 'Location..' to edit the exact location of the point
**DIGITAL OUTPUT CONTROL 2**

**MOVE points**
- Keep the RIGHT button down to move the ON point.
- Keep the LEFT button down to move the OFF point.

**SELECT**
- Left button down: select by dragging over.

**MOVE selection**
- Select ON point; to move selection, keep the LEFT button down.

**COPY selection**
- Click the RIGHT button for the pop-up menu.
- Click the LEFT button for the position to paste.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Erase</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Location</td>
<td>Ctrl+L</td>
</tr>
</tbody>
</table>
10. Select a sequence
   * Drag the mouse pointer with the LEFT button down over the section
to be selected: The selected section turns into **BLUE**.

11. Move a selection
   * Place the cursor on any of the point in a selected section
   * Drag the section while keeping the LEFT mouse button down

12. Edit a selection
   * Place the cursor on any point in the selection
   * Click RIGHT for the edit menu to pop up.

13. Copy, and Paste
   * Select a section
   * Click RIGHT
   * Click 'Copy'
   * Place the cursor at the location to paste the selection (in the same signal
or in any of the other signal strips)
   * Click RIGHT
   * Click 'Paste'

14. Save and Export
   * Program sequences can be saved as *ioc files, or
   * Exported as *csv (comma separated values), which can be opened
and edited in Excel.

15. Editing and creating numerical output control files.
   * Open an exported file in Excel and edit the stored values
   * Create a new Excel file containing the required status times and
changes of the output signals.
   * Only change times and values. Maintain the file format.
   * Import the new Excel file in the IOControl program.

16. Numerical file format
   * Time column: the time (in ms) of all status changes in any of the 8 signals
is presented. In between consecutive times no status change occurs.
   * In the digital signal columns a ' 0' stands for OFF, and a ' 1' for ON.

17. Activating and running the output control sequence
   * Save the file or open an existing file.
   * Click the 'send data to IDAC' button: 🛡
   * Start the output: Click on 🎵
   * Stop: Click on 🌋
Example of output control sequence for 8 channels

The first 25 status transitions of above example exported as csv opened in Excel

<table>
<thead>
<tr>
<th>Time [mS]</th>
<th>Digital 1</th>
<th>Digital 2</th>
<th>Digital 3</th>
<th>Digital 4</th>
<th>Digital 5</th>
<th>Digital 6</th>
<th>Digital 7</th>
<th>Digital 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>51</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>61</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>100</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>400</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>700</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1005</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1305</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1310</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1610</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>1700</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2300</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2325</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>2625</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>2650</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>2950</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>3025</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>3355</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>3421</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>3792</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>4162</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>4518</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>
ANALOG OUTPUTS

1. Start IDAC Output Control

   The output control program is accessible in two ways:
   * After opening a project in Autospike:
     in the File menu: " Idac output control..."
   * In the Wave recording mode: click the IO Control button.

   A new file can be created or an existing one opened in the File menu.

2. Open the 'Select signal' box to select the analog channels to be programmed.
   * By a RIGHT mouse click in the empty Control box, followed by 'add signal'. Or by a click on
   * In the 'Strip' menu select ' Add'.
   * Select the analog channels in the 'Select signal' box

3. Set the total signal duration
   * In the 'View properties' : click:
   * Click the 'Signal duration' button:

4. Adjust the height of the signal strips
   * Click the ' increase' or 'decrease' buttons:

5. Adjust the visible part of the total duration (zoom)
   * Click the " increase or 'decrease' buttons:

6. Adjust the amplitude range in the signal strip
   * Use the 'increase' and 'decrease' buttons:  
   * Zoom to the highest value present:
   * Zoom to the preset range:

7. Setting Time/Value points
   * Select one of the analog signal strips by clicking the name box.
   * Position the cursor and click the LEFT mouse button.

   The exact position of the cursor is presented in the lower right corner of the box

8. Move, Edit, Select, Copy and Paste, Save, Import and Export
   * These operations are similar to those applicable to the digital signals

9. Creating smooth slopes and continuous signal changes
   * Place as many point as necessary to produce smooth output signals.

Note that signal transitions are NOT interpolated between points, although in the signal graphs the points are interconnected. Linear slopes are best created by adding points on a (used or non-used) digital signal on the time section associated with the analog slope.
Add Analog channel

Set duration

Select amplitude range

Place point by LEFT mouse click

Cursor position indicator in lower right corner

Location: time & value

Adjust Location

Select section

RIGHT button down select by dragging
10. Editing and creating numerical output control files.
   * Open an exported file in Excel and edit the stored values
   * Create a new Excel file containing the required status times and
     changes of the output signals in mV.
   * Only change times and values. Maintain the file format.
   * Import the new Excel file in the IOControl program.

17. Numerical file format
   * Time column: the time (in ms) of all status changes in any
     of the 10 signals is presented.
     In between consecutive times no status change occurs.
   * The value in the analog signal columns is presented in mV.

18. Activating and running the output control sequence
   * Save the file or open an existing file.
   * Click the 'send data to IDAC' button: 📋
   * Start the output: Click on 🎉
   * Stop: Click on 🐸

TRIGGER SYNCHRONIZATION

The programmed Output Control sequence of digital and analog signals can be started
independently of the signal recording in Autospike or linked to a trigger command
((Manual, Auto trigger, or External) in Autospike.

* Click the 'Trigger Link' button in the Autospike control bar
* Activate an Autospike trigger command to start both signal acquisition
  and Output signal.

The duration of the pre-set recording Autospike recording time and the duration of the
Output Control are independent.
With the recording in Autospike set to 'automatic save after recording' and one of the
output signals wired to a trigger designated input of Autospike the Output control can be
programmed to start repeated recordings in a pre-programmed sequence.
Example of output control sequence for 2 analog and 2 digital channels

Numerical data of above example exported as csv opened in Excel

<table>
<thead>
<tr>
<th>Time [mS]</th>
<th>Digital 1</th>
<th>Analog 1</th>
<th>Digital 2</th>
<th>Analog 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1500</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1508</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1732</td>
<td>1</td>
<td>1267</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1939</td>
<td>1</td>
<td>2474</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2159</td>
<td>1</td>
<td>3620</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2171</td>
<td>1</td>
<td>3682</td>
<td>1</td>
<td>120</td>
</tr>
<tr>
<td>2354</td>
<td>1</td>
<td>4649</td>
<td>1</td>
<td>1953</td>
</tr>
<tr>
<td>2370</td>
<td>1</td>
<td>4729</td>
<td>1</td>
<td>2113</td>
</tr>
<tr>
<td>2490</td>
<td>0</td>
<td>5328</td>
<td>1</td>
<td>3320</td>
</tr>
<tr>
<td>2498</td>
<td>0</td>
<td>5368</td>
<td>1</td>
<td>3401</td>
</tr>
<tr>
<td>2506</td>
<td>0</td>
<td>-43</td>
<td>1</td>
<td>3481</td>
</tr>
<tr>
<td>2538</td>
<td>0</td>
<td>-42</td>
<td>1</td>
<td>3803</td>
</tr>
<tr>
<td>2721</td>
<td>0</td>
<td>-37</td>
<td>1</td>
<td>5541</td>
</tr>
<tr>
<td>2921</td>
<td>0</td>
<td>-32</td>
<td>1</td>
<td>7606</td>
</tr>
<tr>
<td>3136</td>
<td>0</td>
<td>-26</td>
<td>1</td>
<td>10000</td>
</tr>
<tr>
<td>3144</td>
<td>0</td>
<td>-26</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4100</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>5012</td>
<td>0</td>
<td>4929</td>
<td>0</td>
<td>9577</td>
</tr>
<tr>
<td>5020</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5595</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5619</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Real output slope defined by multiple points on signal plot

Step output change due to missing value points on signal slope
### Numerical data of previous file

<table>
<thead>
<tr>
<th>Time [mS]</th>
<th>Digital 1</th>
<th>Analog 1</th>
<th>Digital 2</th>
<th>Analog 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1500</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1508</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1732</td>
<td>1</td>
<td>1267</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1939</td>
<td>1</td>
<td>2474</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2159</td>
<td>1</td>
<td>3620</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2171</td>
<td>1</td>
<td>3662</td>
<td>1</td>
<td>120</td>
</tr>
<tr>
<td>2354</td>
<td>1</td>
<td>4649</td>
<td>1</td>
<td>1953</td>
</tr>
<tr>
<td>2370</td>
<td>1</td>
<td>4729</td>
<td>1</td>
<td>2113</td>
</tr>
<tr>
<td>2490</td>
<td>0</td>
<td>5328</td>
<td>1</td>
<td>3320</td>
</tr>
<tr>
<td>2498</td>
<td>0</td>
<td>5368</td>
<td>1</td>
<td>3401</td>
</tr>
<tr>
<td>2506</td>
<td>0</td>
<td>-43</td>
<td>1</td>
<td>3481</td>
</tr>
<tr>
<td>2538</td>
<td>0</td>
<td>-42</td>
<td>1</td>
<td>3803</td>
</tr>
<tr>
<td>2721</td>
<td>0</td>
<td>-37</td>
<td>1</td>
<td>5541</td>
</tr>
<tr>
<td>2921</td>
<td>0</td>
<td>-32</td>
<td>1</td>
<td>7606</td>
</tr>
<tr>
<td>3136</td>
<td>0</td>
<td>-26</td>
<td>1</td>
<td>10000</td>
</tr>
<tr>
<td>3144</td>
<td>0</td>
<td>-26</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4100</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>5012</td>
<td>0</td>
<td>4929</td>
<td>0</td>
<td>9577</td>
</tr>
<tr>
<td>5020</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5595</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5619</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Numerical data of after insertion of additional time points on digital 2 signal

<table>
<thead>
<tr>
<th>Time [mS]</th>
<th>Digital 1</th>
<th>Analog 1</th>
<th>Digital 2</th>
<th>Analog 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1500</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1508</td>
<td>1</td>
<td>-15</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1732</td>
<td>1</td>
<td>1267</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1939</td>
<td>1</td>
<td>2474</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2159</td>
<td>1</td>
<td>3620</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2171</td>
<td>1</td>
<td>3662</td>
<td>1</td>
<td>120</td>
</tr>
<tr>
<td>2354</td>
<td>1</td>
<td>4649</td>
<td>1</td>
<td>1953</td>
</tr>
<tr>
<td>2370</td>
<td>1</td>
<td>4729</td>
<td>1</td>
<td>2113</td>
</tr>
<tr>
<td>2490</td>
<td>0</td>
<td>5328</td>
<td>1</td>
<td>3320</td>
</tr>
<tr>
<td>2498</td>
<td>0</td>
<td>5368</td>
<td>1</td>
<td>3401</td>
</tr>
<tr>
<td>2506</td>
<td>0</td>
<td>-43</td>
<td>1</td>
<td>3481</td>
</tr>
<tr>
<td>2538</td>
<td>0</td>
<td>-42</td>
<td>1</td>
<td>3803</td>
</tr>
<tr>
<td>2721</td>
<td>0</td>
<td>-37</td>
<td>1</td>
<td>5541</td>
</tr>
<tr>
<td>2921</td>
<td>0</td>
<td>-32</td>
<td>1</td>
<td>7606</td>
</tr>
<tr>
<td>3136</td>
<td>0</td>
<td>-26</td>
<td>1</td>
<td>10000</td>
</tr>
<tr>
<td>3144</td>
<td>0</td>
<td>-26</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4100</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>5012</td>
<td>0</td>
<td>4929</td>
<td>0</td>
<td>9577</td>
</tr>
<tr>
<td>5020</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5595</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5619</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Adding time points to create smooth linear output signal slope

### TRIGGER LINK  Autospike - Output Control

Adding time points to create smooth linear output signal slope